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Basic Microsoft Outlook 2003
Part 3 — Rules, Tasks, Notes, Options, MavMAIL

This handout is simply an outline to be used agidegin class. Microsoft Outlook offers many wagys
accomplish different tasks. The steps below idigiati least one way to accomplish a task in Micfbso
Outlook. We will explore as much of this prograstiane allows.

RULES

The Rules Wizard helps you manage your e-mail ngesshy using rules to automatically perform actions
messages. After you create a rule, Microsoft Quktlapplies the rule when messages arrive in yduwXror
when you send a message.

The steps below create a rule that moves a mefsagehe Inbox to a specific folder. Before théeris
created, a folder should be created.

Create a Folder

1.

On the File menu, point to New, and then click
Folder.

2. In the Name box, enter a name for the folder.
3.

In the Select where to place the folder list, clic&
location for the folder.
Click OK.

Create Mew Folder

MName:

Folder contains:

Mail and Post Tkems

Select where to place the folder:

= %?f Mailbioz - Villwock, Shannon L
+ j Calendar
5= Contacts
£ ’En' Deleted Items (6
L;# Drafts [5]
|1 Fronkier account
L] Inbox
H [ IT5
4 Journal
L@ Junk E-mail
| Motes

Ik

] [ Cancel
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Create a Rule

1. Click the Inbox. Crreg iy (e 12JE3

2. On the Tools menu, click
Rules and Alerts...

E-mail Rules | Manage Alerts |

3. C||Ck the New Rule_ . [25y Mew Rule... Change Rule + 523 Copy. .. >( Delete | Run Rules Mow, .. Options
button . Rule {applied in the arder shawn) Actions
] Shannon Yillwock 5

Rule description {click an underlined value to edit):
Apply this rule after the message arrives
sent ko Shannon Yillwock
move it ko the

coount falder

oK ]| Cancel |[ Apply

Rules Wizard

{(®)5kart creating & rule From a kemplake:
() Start from a blank rule

4. Choose the type of rule you want tg tep 1: Select a template

create and click Next. For our Stay Organized
example choose Move messages -3 Move messages From someone to & Folder
; 3 Move messages with specific waords in the subject to a Folder
from someone to a folder. = c peRic wares n :
5 Click Next L Move messages sent to a distribution list ko a folder

X Delete a conversation
¥ Flag messages from someone with a colored Flag
Stay Up to Date
<. Display mail From someaone in the Mew Ikem Alart Window
i Play a sound when I get messages from someone
a Send an alert to my mobile device when I get messages from someone

Step Z: Edit the rule descripkion (click an underlined value)

Apply this rule after the message arrives
From people or diskribukion lisk
miove it ko the specified Folder

Example: Move mail from my manager to my High Importance folder

Mext > | | Finish
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6.

Rules YWizard

In the Edit the rule description box,
click the people or distribution list
link to choose the person or

distribution list that this rule applies
to.

[ with

[ with

Which condition{s) do wou want to check?
Step 1 Select condition(s)

from people or diskribution lisk

[ ] through the

[ ] sent only to me
[ ] where my name is in the To box

[ ] marked as

[ ] marked as

[] flagged For

] where my name is in the Cc box

[ ] where mv name is in the To or Cc box
[ ] where mv name is not in the To box
[ ] sent to

in the subject
accounk

in the body

Sktep 21 Edit the rule description {click an underlined walue)
Apply this rule after the message arrives

fromipeople or diskribukion lisk§

maove it ko the specified Folder

Cancel ][ « Back ” Bext = l[ Finish

]

Choose the person or distribution list from
the address book that you want used in the
rule. Click OK.

Click Next.

-

Rule Address

=,

Type Mame or Select Fram Lisk; Showe Mames Fram the:

spiess Global Address List w

| Mame Business Phone Off

Spiess, Annetke K (507} 339-6920 Ii[ |

Spiess, Brielle Reed s |
Spiess, Donald Eugene (507) 337-2628 3
Spiess, Joshua Bryan 3
Spiess, Larry E (507) 339-2157 F
Spilde, shawn Peter g
Spillers, John David (507 332-4076 3
Spinner, Amie Lane (507) 339-1962 3
Spiotka, Amy Dawn 5
Spisak, Christina (5077 339-6043 3
Splett, Christopher 9
Splett, Gary R {5071 359-2071 P
splinter, Joshua James 3

Splinter, Sarah Elizabeth Sp

_ Spoden, Elisabeth Jo (507) 335-1323 Sl
>

From -=

L4

(0] 4 l [ Zancel
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9. In the Edit the rule description box, click the gified link to choose the folder you want to move thésrit
to.

-,

Rules Wizard

What do you want o do with the message?
Step 1: Select actionis)

move it to the specified Folder S
[l assign ik ko the category

[] delete it

[] permanently delete it |
] move a copy to the fFalder 3
[ forward it to

[ forward it ko as an attachment

[] redirect it ta

[ ] have server reply using

[ reply using

[ flag message for

[ flag message with

[ tlear the Message Flag [V]

Step 2: Edit the rule description (click an undetlined walue)

Apply this rule after the message arrives
From Spiess, Annette K

[ Cancel ][ < Back ” fext = ][ Finish

10. Choose the folder from the folder list and click OK
11.Click Next.

Rules and aAlerts

Choose a folder:
= @ Mailbio: - Willwock, Shannon L Fs

cal e |
i=| Contacks
5 Deleted Items (72 Mew. ..
L7 Drafts [5]
|1 Frontier account
[ 7] Inbox (1)
3 1Ts
éﬂ- Journal
L@ Junk E-mail
o | Motes

[ outbox
[ Personal [v]

Cancel
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12.Choose any exceptions to the rule[n, 1os Wizard

if necessary, and click Next.

Are

|
0
O
O
O
O
O
O
0

ap)
fro
mo

there any exceptions?

Step 1 Select exception(s) {if necessary)

[ iexcept if From people or distribukion list

except if the subject conkains

except through the account
except if sent only to me

except where my name is in the To box
except if it is marked as

except if it is marked as

except if it is flagged For

except where my name is in the Co box
except if my name is in the To or Cc box

[] except where my name is nok in the To box
[] except if sent to
[ ] except if the body contains

Sktep 21 Edit the rule description {click an underlined walue)

ply this rule after the message arrives

m Spiess, Annetke k
ve it ko the Annette Folder

Cancel ][ « Back

x> ] |

Finish |

13. Specify a name for this rule. If you want
to run a newly created rule on message
already in the Inbox, select the Run this
rule now on messages already in “Inbox

-

Rules Wizard

Finish rule setup.

Skep 1: Specify a name For this rule

Aannetke

FF

Step 2; Setup rule options

" [#]Run this rule now on messages already in  Inbos

check box. Click Finish.
14.Click Finish to close the Rules Wizard
dialog box.

Turn on this rule

Step 3: Review rule description (click an underlined value to edit)

Apply this rule after the message arrives

fram Spiess, Annette K
miove it bo the Annette folder

) |

’ Zancel < Back
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DELETING A RULE

1. Click Rules and Alerts from the Tools menu.
2. Click on the rule that you want to delete.
3. Click on the Delete button in the dialog box.

Rules and Alerts

| E-mail Rules !f-.qanage p.!ertéj

[ Mew Rule... Change Rule~ 52 Copy.. ?Q Delete i % PRunRules Mow,., Options

Rule {applied in the order shown) | yckions
I [w'] Annette 5
[w] Evers, TheresaV 23
| |# shannon Yillwaock: (a3

Rule description (click an underlined walue ko edit):
apply this rule after the message arrives
From Spisss, Annette K
move it to the Annette Folder

|_ Ok |[ Cancel ][ apply

4. Click Yes in the dialog box to finish deletitige rule.
5. Click OK when finished.

‘Microsoft Office Outlook

! E Delete rule "&nnetke!?
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TASKS

A task is a personal or work-related errand yout@itrack through completion. A task can occuceoor
repeatedly (a recurring task). A recurring task egpeat at regular intervals or repeat based@ddlte you
mark the task complete. For example, you mighttvaareminder to print your pay stub every otherkvee

In addition to creating your own tasks, you caratedasks that you assign to others. You do thseiding a
task request to someone. The person who recdiedsask request becomes the temporary owner aashe

Create a Task

On the File menu, point to New, and then click Task
In the Subject box, type a task name.
Complete any other boxes on the Task and Detditsfta information you want to record for the task.
To make the task recur, click Recurrence, clickftequency (Daily, Weekly, Monthly, Yearly) at whic
you want the task to recur, and then do one ofdtewing:
Make the task recur at regular intervals
0 Select options for that frequency. Do not click Begrate new task or the task will not recur at
regular intervals.
Make the task recur based on completion date
o Click Regenerate new task and then type a timeuéegy in the box.
Set start and end dates for the task.
Click OK and then click Save and Close.

PwppPE

oo

NOTES

Notes are the electronic equivalent of paper stiakigs. Use notes to jot down questions, ideasnaars, and
anything you would write on note paper. You cavénotes open on the screen while you work. Bhis i
especially convenient when you're using notestfanirgg bits of information you may need later, sash
directions or text you want to reuse in other itemgocuments.

Create a Note

1. On the File menu, point to New, and then click Note

2. Type the text of the note.

3. To close the note, click the note icon in the udpércorner of the Note window, and then click €#cOR
click the x in the upper right corner of the note.

Note: You can leave the note open while you work. Wiem change the note, the changes are saved
automatically.
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OuTLOOK OPTIONS AND PREFERENCES

To modify Outlook to look the way you want and walnle way you want, change some of the options.es&c
the options through the Tools menu and then clipkdDs.

Preferences
Options @@

Preferences | Mail Setup | Mail Format | Spelling | Security | Other | Delegates |

E-mail
. hange the appearance of messages and the way they are handled, |
- | Jurk E-mnail, . | [ E-mnail Options. .. ] [
Calendar |
Customize the appearance of the Calendar. |
Default reminder: 30 minukes | % | [Calendar Options... | |
' |
Tasks
= Change the appearance of tasks,
Reminder time; 300 AM . V' Task Options. ..
Conkacks
Q : Change default settings For contact and journal,
E Conktack Options. .. ] [ Journal Cptions.. , l
Maotes

Change the appearance of notes,
- Mote Options,. .

[ Ok ] [ Cancel

Junk E-mail Options
Junk E-mail Options &3

Options | Safe Senders || Safe Recipients | Blocked Senders

i" 1 Outlook can mave messages that appear to be junk e-mail into a special |
L@ JunkE-mai folder,

Choose the level of junk e-mail protection you wank; |

(7)Mo Automatic Filkering. Mail from blocked senders is still mawed to
the Junk E-mail Falder. |

(@ Low: Mave the most obwious junk e=mail ko the Junk E-mail Falder.! ‘

() High: Mast junk e-mail is caught, but some regular mail may be
caught as well. Check wour Junk E-mail Folder often.

() 5afe Lists Only: ©nly mail from people or domains an your Safe
Senders List or Safe Recipients List will be delivered to yvour Inbos,

[ ]Permanently delete suspected junk e-mail instead of maving it to the
Junk E-mail Falder

[ OK_][ Cancel
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E-mail Options
E-mail Options

Message handling

Afker moving or deleting an open item:  |return to the Inbox V
Close original message on reply or Forward

Save copies of messages in Sent Items Folder

Automatically save unsent messages

Remove extra line breaks in plain text messages

[Tread all standard mail in plain text

[ fdvanced E-mail Options. .. ] [ Tracking Options. ..

On replies and forwards

_:;I ‘When replying to a message

=y 5
=58 | Include ariginal message text [

‘When Forwarding a message

Include original message text ¥

[T mark my comments with:

I K ] [ Cancel

Advanced E-mail Options

-

Advanced E-mail Options

Save messages
Save unsent items in; | Drafks w

AutoSave unsent every: |3 minukes

In Folders other than the Inbox, save replies with original message

Save forwarded messages

When new items arrive in my Inbox

Flay a sound

Briefly change the mouse cursar

Show an envelope icon in the notification area
Display a Mew Mail Deskiop Alert (default Inbox only)

[ Deskiop Alert Settings. .. ]

When sending a message
Set importance: | Mormal
Set sensikivity: | Mormal

[ |Messages expire after: days

[ allaw comma as address separator

Autornatic name checking

[]pelete meeting request from Inbox when responding
Suggest names while completing To, Cc, and Beoc Fields

[ ] add properties to attachments o enable Reply with Changes

[ (8] 4 l [ Cancel

Page 9 of 16




Tracking Options
Tracking Options

Options

IUse these options to verify the date and time a message has
@é been received by the recipient,

[v]Process requests and responses on arrival

Process receipts on arrival

|:| After processing, move receipts ko

[ ] Delete blank voting and meeting responses after processing
Far all messages I send, request;
[ |Read receipk

[ ] Delivery receipt

IUse this opkion ko decide how to respond o requests For read
receipts, Only applies ko Internet Mail accounts,

() always send a response
{(®) Mever send a response

() &sk me before sending a response

[ (99 ] [ Cancel

Calendar Options

Calendar Options

Calendar work week

Man Tue Wed Thu Fri [ ]sat

Firsk day of week: | Sunday W | Stark time: | 7i30 AM il

.
[]
=

=3

Firsk week of wear: |StartsonJanl || Epdtime: | 5:00 PM ¥ |

Calendar options

[]shaw week numbers in the Date Mavigatar
o
Allow attendees to propose new times for meetings vou organize

Use this response when wou propose new meesting times: | Tentative v

Background color: w Flanner Options. .. ] [ Add Holidays. ..
[ Juse selected backgraund color on all calendars

fdvanced options
Enable alternate calendar: | English w | | Gregorian W

When sending meeting requests aver the Internet, use iCalendar Format

[ Eree(Busy Options. .. ] [ Resource Scheduling. .. ] [ Time Zone. .. ]

[ (0]4 l[ Cancel ]
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Task Options

Task Options

Task options
=

j Cverdue task color:

keep updated copies of assigned tasks on my task list
Send status reparts when assigned tasks are completed
Set reminders on tasks with due dates

(0] 4 l [ Cancel

Contact Options

-

Contact Options

-,

Mame and Filing options For new contactks

| E

Conkacks Index options

a = [] shows an additional Contacts Indes

Select the order wou would like Outlook to use For new names:

Defaulk "Full Mame" order: |First (Middle}) Last &I

Select the default setting For how ko file new contacts;

Default "Bile As" order: |LastJ Firsk BI

Check for duplicate contacts

gdditional Contacks Index:

Notes Options

L =1

Motes Options

Motes appearance

‘&J Color: | Yellow M

Sizet | Medum ™
10 pt. Cammic Sans M3

[ (]9 H Cancel ]
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Mail Setup Options
Options @@

| Preferences | Mail Setup | pMail Format | Spelling | Security | Other | Delegates |

-

E-mail Accounts

g Setup e-mail accounts and direckaries,

| E-mail Accounts,., .

SendjReceive

3 Set send and receive settings for e-mail messages and documents.
=

Send immediately when connected [ sendiReceive... ]

[rata Files

s« Change settings for the files Outloak uses ko store e-mail messages
ﬁ_g and documents,

[ Data Files. .. ]

Dial-up

-.-/L." Cantral how Qutlook connects ko vour dial-up-accounts.

\# (%) Warn before switching an existing dial-up connection
() Always use an existing dial-up connection
[] aukomatically dial during a background SendfReceie
Hang up when Finished with a manual Send/Receive

l (w4 ] [ Cance

Mail Format Options
Options @@

Preferences || Mal Setup | Mail Format | Speling I ;Security Other || Delegates |

e

Message Format

_j_.J Choose a Format For oukgoing mail and change advanced settings,

Compose in this message format: |

L

IUse Microsoft Office Word 2003 to edit e-mail messages
Use Microsoft Office Wword 2003 to read Rich Text e-mail messages

[ Internet Format. .. ][Lnternatiu:unaIOptiu:uns...

Stationery and Fonks

| Use stationery to change your default font and stvle; change colors,
A(' «  and add backgrounds to your messages.
Use this skationery by default: <Mone= iv‘

Eonts, ., H Stationery Picker...

Signatures
\ |
__6'(_’; Select signatures for account: [MsU

Signature for new messages: ithanks

Signature For replies and Forwards: éthanks

[ Signatures, .. ]

[ Ok, l [ Canicel
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Fonts

Fonts

Message fonts

-

}P YWhen composing a new message;
f—-’ 12 pt. Timas Mewr Foman

When replying and forwarding:

12 pt. Times Hew Eoman Choose Fank, ..

YWhen composing and reading plain bext:

12 pt. Timnes Hewr Roman Choose Fonk, ..

Automatically display Rich Text in draft
fFonk when using high contrast

[ International Fonks., ..

Skationety Fonks

Some stationeries have fonks associated with them. You
can choose ko always use your fonts instead of the ones
specified in the stationery.

() Use the Font specified in skationery (if specified)
() Use my Fort when replying o and Forwarding messages

(%) Always use my Fonts

[ (04 ] [ Cancel

Stationery Picker

Stationery Picker

Edit...
@ Citrus Punch |
@] Clear Day Remave
@ Currency Newt
@ Fiesta —

Glacier |

L v

Presview:
Get More Stationety ] [ (o] 4 l [ Zancel
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Spelling Options

Security Options
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Other Options

Delegates
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MAVMAIL /OWA/OuTLoOK WEB ACCESS

You can access the Exchange server (your e-mait) aimy computer that has Internet access. Theadeiess
is http://mavmail.mnsu.edu.

Internet Explorer 6.0 login box (Windows XP)

Netscape Communicator 7.1 login box (Windows XP)

Open the browser (Internet Explorer or Netscape).
Type in the following web address: http://mavmaiisu.edu and press Enter.
Click on one of the links to access your account:

wN P

MavMAIL Secure Logon

MavMAIL Standard Logon _ (Best for dial-in connections)

4. When the login box appears, type your User namePaisdword. Many of the functions and features used
in Microsoft Outlook are available in the web versand are used in the same manner.
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